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TASK: Capturing and Submitting Lesson Videos

Your task is to capture and format all your video materials for the creation of your performance support lessons for your 
chosen product. 

IMPORTANT: You must use Camtasia Studio to record your videos—no exceptions.

 ● Videos are captured while you demonstrate each step of a lesson for the selected product.

 ● PowerPoint presentations are used to introduce and explain concepts.

 ●  Lesson audio should be either pre-recorded in accordance with the Recording Audio Guide or narrated as you 
perform the lesson steps.

See the Lesson Planning Guide for instructions on how to plan what you will say and do in your videos, as well as more 
information about creating demo or exercise files prior to recording.

IMPORTANT: Realize that, as you are recording, everything that you show in the interface will be seen in the 
video! Be aware of displaying corporate or personal information that may be sensitive in nature!

Strongly Recommended Best Practices:

Set up a generic email if your product requires an online sign-in and you do not want your personal or 
professional email to show in the video, such as “poweruser567@gmail.com”.

Set up a generic folder structure in your local system for any demo or exercise files that you will be accessing 
during the course of recording the lesson. Use folder names such as “my_project”, and for file names, use 
generic terms that summarize the lesson objective. For example, if you are demonstrating how to create a new 
project, use “MyProject”.

While it is possible to blur some sensitive information within the videos, this is a time-consuming post-
production process that, if needed excessively, could result in additional production costs and delays in 
receiving your deliverables.

OUTCOME: A Comprehensive Lesson Video

The CADLearning Post-Production team helps ensure that the quality of your final videos reflects our high standards. If 
our producers watch a video and determine that it does not meet those standards, you will be asked to re-record your 
video, and possibly your audio as well. Reasons for this can include, but are not limited to:

 ● The interface does not reflect what is said in the narration.

 ● The functionality of the task does not match the step-by-step instructions within the narration.

 ●  An aspect of the interface element in question does not match the narration, such as the color, location, and 
exact name of the element.

 ● A video is longer than 8 minutes.
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Thoroughly double-checking and testing the functionality of your program before you start recording either your audio or 
your video will eliminate many of these problems. 

Once your video files have been uploaded and approved, the narration will be extracted and produced into the final 
format for inclusion in the product library.

PROCEDURE: Recording Videos Using Camtasia Studio Recorder

All videos must be recorded using Camtasia Studio software from TechSmith Corporation. CADLearning can work with 
Camtasia Studio version 9 through 2018, and this guide is based on version 9.

You will use the Camtasia Studio Recorder to record your lesson videos. You can start the Camtasia Studio Recorder 
using one of the following methods:

 ● Click the Record the screen button located on the Camtasia Studio welcome screen.

 ● Click the Record the screen button located in the main Camtasia Studio window. 

You can also start the Camtasia Studio Recorder from the TechSmith program group in the Windows Start menu.

Before you start recording, ensure that you configure the proper settings.

Configuring Camtasia Studio: Recording Tools Options

The following instructions describe how to configure Camtasia Studio Recorder to properly record your lessons. Please 
be sure that your settings match those shown exactly to ensure that the videos you produce match the required settings.

1.  After you click Record the screen…, in the Camtasia Studio Recorder menu, select Tools > Options to display 
the Tools Options dialog.
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2. Next, click the File options… button to display the File Options dialog.
3.  In the File Options dialog, under Output folder, specify the folder to which raw captured videos will be saved 

(the /camtasia/raw folder). Then, under Output file name, select Ask for file name. This ensures that Camtasia 
Studio will prompt you for a file name whenever you finish recording a lesson video. At that point, you will need to 
ensure that files adhere to the CADLearning file naming convention as described in Welcome to CADLearning. 

You can use Camtasia Studio’s automatic file naming mechanism if you wish, or even skip this step, as long 
as the resulting files are saved in the proper folder and the file names match the CADLearning file naming 
convention as outlined in the welcome document.

When finished, click OK to close this dialog.

4. On the Inputs tab, under Screen, expand the Record to: drop-down and select H.264.
5.  Also on the Inputs tab, under Audio, for the Audio device, expand the drop-down and select your attached Mi-

crophone. This will record your narrative as you are capturing your video. (Note that if you are recording based 
on a pre-recorded audio, you would set this option to Do not record microphone instead.)
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6.  Review the Hotkeys settings on the Hotkeys tab. Typically, pressing F9 starts the Camtasia Studio recording or 
pauses the recording. Pressing F10 stops the recording. You can reassign key combinations, if necessary.

7. Click OK to close the Tools Options dialog.

Configuring Camtasia Studio: Recording Effects Options

The following instructions describe how to configure various Camtasia Studio Recorder effects to properly record your 
lessons. Please be sure that your settings match those shown exactly, to ensure that the videos you produce match the 
required settings.

1. In the Camtasia Studio Recorder menu, select Effects > Options to display the Effects Options dialog.

2.  On the Annotation tab of the Effects Options dialog, make sure that none of the available options are selected. 
Do  not include system stamps or captions as part of your captured videos.
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3.  On the Sound tab of the Effects Options dialog, drag the Volume slider all the way to the left so that you do not 
record the sound of mouse clicks. 

4. Click OK to close the Effects Options dialog.

Configuring the Size of the Video Capture

The captured video window must measure exactly 1920x1080! Since you will be recording a display that has been 
configured to display at a resolution of 1920x1080, all captured video must adhere to this requirement.

Use the following steps to ensure the size of the video capture window.

To capture just the application window (typical):

1. Start the application you will be teaching (such as AutoCAD).
2.  Move the application to the second display (with a resolution of 1920x1080) and maximize the application so that 

it fills that display.

IMPORTANT: Hide the task bar on the second display, unless you are recording a lesson that actually involves 
the use of the task bar. 

3.  In the Camtasia Studio recorder panel, expand the Custom drop-down, choose Select Area to Record, and 
then click the border of the application window to specify the portion of the screen that is to be recorded.

IMPORTANT: As you move the cursor over the border of the window, the border highlights. Once you select 
the window, you will see a dashed green line surrounding the application window, and the Dimensions in the 
Camtasia Studio Recorder panel will indicate that the capture area is exactly 1920x1080. If necessary, you can 
repeat this step until the proper window has been selected.
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4.  In the Camtasia Studio recorder panel, expand the Custom drop-down again and make sure Lock to Applica-
tion is selected. This ensures that Camtasia Studio will continue to capture the application window you specified, 
even if you move the window on your desktop. 

IMPORTANT: if you change the size of the application window, the size of the area captured by Camtasia Studio 
will also change, so take care not to resize the application window.

Recording Your Lesson Video

You will record your lesson video while playing and listening to the previously recorded narration. The resulting .trec file 
will then contain both the audio and video. 

Note: If you will be recording the lesson audio as you step through the lesson while capturing, skip to the next section.

To record your lesson video in sync with the previously recorded audio:

1. In the Camtasia Studio Editor, start a New project.
2. Click Import Media, select the audio file that contains the audio narration for the lesson you are about to record, 
and click Open. (You can also drag-and-drop from Windows Explorer to add files to the Camtasia Studio Media Bin.)
3. Drag the audio file from the Media Bin and drop it onto Track 1.
4.  Make sure that the application you are about to record (such as AutoCAD) is open, has been set to the proper 

size (1920x1080), and everything is set up in the program for the start of your lesson.
5. Open the Camtasia Studio Recorder.
6.  Expand the Audio drop-down and make sure that the options 

Do not record microphone and Record system audio are 
both selected (as shown). 
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7. Click the Record button.
8.  After the recorder counts down and starts recording, switch back to the Camtasia Studio Editor, click to Play 

the narration audio you previously recorded, and immediately minimize the Camtasia Studio Editor window. 
Switch back to the application you are recording (such as AutoCAD) and start performing your actions in sync 
with the narration.

IMPORTANT: This can take a bit of practice. It also means that you will want to have a long enough duration of 
silence at the beginning of your narration track to enable you to perform this step.

9. When you finish recording your video, click the Stop button.
10. You will then be prompted to name and save the recording. 

11.  Save your .trec file. Be sure to give it a file name that adheres to the required CADLearning file naming conven-
tion and matches the name of the audio file (for example, 123456_abcd22.trec; to match the name of the audio 
file, which would be 123456_abcd22.wav).

To record your lesson video while recording live audio:

1. In the Camtasia Studio Editor, start a New project.
2.  Make sure that the application you are about to record (such as AutoCAD) is open, has been set to the proper 

size (1920x1080), and everything is set up in the program for the start of your lesson.
3. Open the Camtasia Studio Recorder.
4.  Expand the Audio drop-down and make sure that the option for your microphone is selected, and that Record 

system audio is not selected (as shown). 
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5. Click the Record button.
6.  After the recorder counts down and starts recording, switch to the application you are recording (such as 

AutoCAD) and start performing your actions in sync with your spoken narration.

IMPORTANT: This can take a bit of practice. It also means that you will want to have a long enough duration of 
silence at the beginning of your narration track to enable you to perform this step.

7. When you finish recording your video, click the Stop button.
8. You will then be prompted to name and save the recording. 

9.  Save your .trec file. Be sure to give it a file name that adheres to the required CADLearning file naming 
convention and matches the name of the audio file (if used) (for example, 123456_abcd22.trec, to match the 
name of the audio file, which would be 123456_abcd22.wav).

As soon as you save the .trec file, Camtasia Studio will load it into the Media Bin. Verify that the recording dimensions 
are 1920x1080. To do this, at the top of the canvas, expand the Canvas Options drop-down and choose Project 
Settings… to open the Project Settings dialog. 
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If you do not see this dimension, then you most likely recorded your video at the wrong resolution and will need to record 
it again (after first adjusting the resolution of the second display and then maximizing the application window so that it 
fills the second display). Remember, your video MUST be 1920x1080!

The .trec file should now appear in the Media Bin.

10. Drag the .trec file from the Media Bin and drop it onto Track 2.

Once you complete this step, the Camtasia Studio timeline will contain two tracks:

 ● Track 2: The video you just recorded (labeled “Screen”) which contains both audio and video.

 ● Track 1: The previously recorded audio file (if used).

TIP: By default, Camtasia Studio only shows the upper half of the Audio sound graph. To see the full sound graph, in 
the menu, select Edit > Preferences… to display the Preferences dialog. In the Preferences dialog, select Mirror 
Waveform, and then click OK to close the dialog.

NOTE: This section is ONLY if you pre-recorded your lesson audio.

Now comes the tricky part:

11. Use the Zoom tools (located directly above the timeline) to zoom in on the beginning of the track.
12. Drag the recorded video on Track 2 until it lines up with the Audio sound graph on Track 1.
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IMPORTANT: You can click Play and listen to the audio to make sure that the two tracks are properly aligned. This 
does not have to be perfect. If it sounds like an echo chamber, you are close enough.

13.  Move the playhead to the point at which the audio begins, take note of its position, and then move it 
approximately 2 seconds to the left. (You will need to make sure that no action occurs in your video prior to this 
location.)

14.  Click and drag the In Point (the green control) to the very beginning of the timeline. Then click the Cut tool to 
remove the highlighted portion from both tracks.

15. Select the video trac and then in the properties pane, click and drag the audio Gain down to 0%.
16.  Use a method similar to step 14 to trim the end of the lesson, making sure that there are approximately 4 

seconds of silence and no additional mouse movement at the end of the lesson.
17.  Select File > Save (or press CTRL+S) to save the Camtasia Studio project, being sure that its file name adheres 

to the required CADLearning file naming convention and matches the name of the audio file and the .trec file. 
(For example, if the audio file was 123456_abcd22.wav, then the .trec file would be 123456_abcd22.trec, and 
the Camtasia Studio project file would be 123456_abcd22.tscproj.)

Using Other Tools While Recording Your Video

Although Camtasia Studio provides tools for adding effects while you are recording your videos (such as circles and 
arrows), you MUST NOT use these tools. All effects will be added by the producer during post-production. If you 
want a specific effect or callout to be added, inform the producers of the name of the effect or the text for the callout, and 
provide the time stamp of the appropriate point in the video.

Recording PowerPoint Presentations

When creating a PowerPoint presentation, you should start with the 4D PowerPoint Presentation Template provided 
in the 4DStandards/templates folder. You should also use the following steps to configure PowerPoint so that your 
presentation is displayed and captured on the second display, which has been configured to the proper resolution 
(1920x1080):

1. In PowerPoint, on the Slide Show tab, click Set Up Slide Show.
2.  In the Set Up Show dialog, in the Show type group box, select Presented by a speaker (full screen) and then 

click OK.
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Camtasia Studio provides enhanced capabilities to help you record PowerPoint presentations. The controls for setting up 
a PowerPoint recording using Camtasia Studio are provided directly within PowerPoint. To access those tools, select the 
Add-ins tab. The Camtasia Studio recording tools are located in the Custom Toolbars panel.

You will use the following Camtasia Studio tools to record your PowerPoint presentations:

Begins recording your PowerPoint presentation

Records audio for the PowerPoint slides (should be selected)

Displays additional options for recording

Since you have already recorded your audio, when you record a PowerPoint presentation, you will use steps similar to 
those used when recording the video within the application you are teaching. Click the Options button and check the 
recording options before proceeding to make sure that they match those shown below.
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Verify the following options:

 ● Start recording paused is selected (so that recording does not start as soon as you close this dialog)

 ● Include watermark is NOT selected

 ● Record audio is selected

 ● Audio source is set to your microphone 

 ●  Capture system audio is selected (so that Camtasia Studio captures your pre-recorded audio as it plays, while 
you record your PowerPoint presentation)

To record your PowerPoint presentation in sync with the previously recorded audio:

1. With Camtasia Studio open on the first display, start a new project.
2.  Import the audio file (the .wav file) containing the audio narration for the PowerPoint lessons you are about to 

record.
3. Drag the audio file from the Media Bin and place it into Track 1.
4. Switch to PowerPoint and load the PowerPoint presentation you are about to record.
5. In PowerPoint, on the Add-ins ribbon, in the Custom Toolbars panel, click Record.
6.  The PowerPoint presentation opens in presentation mode on the second display and a Camtasia Studio dialog 

opens in the lower-right corner of the screen. To begin recording your presentation, click the Click to begin 
recording button.

7. Switch back to the Camtasia Studio Editor, click Play to start playing the narration audio.
8.  Switch back to PowerPoint and immediately move your cursor out of the way so that it is not captured in  

the video.
9. Control your PowerPoint presentation as you normally would during recording.

TIP: While recording your PowerPoint presentation, you can press Page Down to advance through the presentation.

10. Press ESC to stop recording.
11.  You will see the Camtasia Studio PowerPoint Add-in dialog, asking what you would like to do. Click Stop 

recording.
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12.  The Save TechSmith Recording As dialog will display, so that you can save your recording as a .trec file. 
Navigate to the proper folder and be sure to give the file a name that adheres to the required CADLearning file 
naming convention and matches the name of the audio file, and then click Save. (For example, if the audio file 
was 123456_abcd22.wav, then the .trec file would be 123456_abcd22.trec.) 

13.  The Camtasia Studio for PowerPoint dialog opens, asking what you would like to do. Choose the option, Edit 
your recording, and then click OK.

At this point, your computer will switch back to the Camtasia Studio Editor and the PowerPoint presentation will appear 
in the Media Bin (as a .trec file). Verify that the recording dimensions are 1920x1080. To do this, at the top of the 
canvas, expand the Canvas Options drop-down and choose Project Settings… to open the Project Settings dialog.

If you do not see this dimension, then you most likely recorded your video at the wrong resolution and will need to record 
it again (after first adjusting the resolution of the second display). Remember, your video MUST be 1920x1080!

14. Drag the .trec file from the Media Bin and drop it onto Track 2, making sure that it is at the left end of the track.

Once you complete this step, the Camtasia Studio timeline will contain two tracks:

•  Track 2: The video captured from the PowerPoint presentation (labeled “Screen”), which contains both audio 
and video.

Now you can follow steps identical to those previously described for the application lesson videos.

At this point, since you do not add any other effects to videos of PowerPoint presentations, you are done. The .trec, 
.camproj, and .wav files should all be in your /camtasia/raw folder. You will share these files on the 4D Technologies 
OneDrive so that the producer can produce the final lesson.
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PROCEDURE: Producing Your Lessons

Once you have finished editing your lesson or PowerPoint video and saved the Camtasia Studio project file a final 
time, it is ready to be produced. Other than uploading the necessary files to the server (as described in the Welcome to 
CADLearning Guide and System Setup Guide), your work on the lesson is complete.

IMPORTANT: Before uploading the lesson files, you must ensure that all files referenced by the Camtasia Studio project 
(the .trec, .tscproj, audio files, and any images or other files that appear in the Camtasia Studio Media Bin) are located in 
the \camtasia\raw folder.

EXAMPLE: \abcd22\camtasia\raw

The files you will upload are: 

 ● the edited audio file (the .wav file)

 ● the video recorded using Camtasia Studio (the .trec file)

 ● the Camtasia Studio project file (the .tscproj file)

 ● any other files you may have included as part of the lesson

With the exception of the actual Camtasia Studio project file (the .tscproj file), the other files should all appear in the 
Media Bin in Camtasia Studio.

PROCEDURE: Recording Mobile Videos

When using a mobile device to record video content, please adhere to the following:

 ● Resolution: 1080p, 30 frames per second

 ● Format: mp4 at the highest quality possible for the device

If you’re capturing video directly from a tablet or phone, the video should be a landscape orientation only (horizontal 
picture).

If you’re capturing the screen of an application, maintain the screen format and CADLearning will utilize that format for 
post-production. If possible, capture it in a landscape orientation.

PROCEDURE: Uploading Your Files

CADLearning uses Microsoft SharePoint to manage all lesson assets used when working with Camtasia Studio  
(the .tscproj and .trec files, as well as the .wav audio file for the lesson narration and any other files that appear in  
the Camtasia Studio Media Bin).

As soon as you have finished your lesson, you must share all of these files to the appropriate folder on SharePoint (as 
described in the Welcome to CADLearning Guide and System Setup Guide).

Be sure to track which assets you have uploaded in the planning sheet you were provided.
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CHECKLIST

Please refer to this Recording Guide Checklist to ensure that you meet all of the requirements for creating questions. 
(You may wish to print this page and keep it handy as a reference.)

 ● Set up a generic email to avoid displaying sensitive personal or corporate information.

 ● Set up a generic folder structure as described in the Welcome to CADLearning Guide.

 ● �Configure�your�system�as�described�in�the�System�Setup�Guide�so�that�you�record�with�a�screen�resolution�of�
1920x1080.

 ● �Create�exercise�files�as�necessary,�ensuring�that�there�will�be�no�display�of�sensitive�personal,�corporate,�or�client�
information�in�the�video.�

 ● Use Camtasia to capture your video while you demonstrate each step of a lesson.

 ● Use PowerPoint presentations to introduce and explain concepts.

 ● Use pre-recorded lesson audio to guide you as you perform and record the lesson steps.

 ● Edit your recordings as instructed in this guide.

 ●  Save the files and upload them as instructed in this guide into the appropriate SharePoint folders for the 
Production Team.

Questions? Contact support@cadlearning.com.

mailto:support@cadlearning.com
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